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PDS Client Accounting to
Creative Solutions Accounting

Conversion Guide

The Utilities / Data Conversion / PDS command in Creative Solutions Accounting (CSA) is provided to convert
data files from The PDS Client Accounting (PDS) into the Write-Up Solution for Windows bundle of modules
within CSA. This conversion guide explains the necessary steps to convert your data, to identify the fields that
will not be converted, and to document exceptions that you may encounter during the conversion process. The
last section of this document explains the steps you should take to verify that the converted data is correct.

Please review this document in its entirety before actually beginning the conversion process for a client.

CONVERSION PROGRAM OVERVIEW
The overall objective of the PDS Client Accounting (PDS) to Creative Solutions Accounting (CSA) conversion
program is to provide a comprehensive conversion of your PDS data to CSA. However, due to differences in
processing calculations, and data structures between PDS and CSA, some PDS data cannot be converted. Therefore,
you should not expect to exactly duplicate results from PDS using the converted data without adding or
modifying the appropriate data in CSA. The specific items that cannot be converted and conversion exceptions
are listed in the section in this document entitled “Conversion Notes and Exceptions.”

Note: Payroll check information is not converted from PDS to CSA. It is recommended that you convert your client
data at the beginning of a new quarter or year, as some reports my not calculate correctly if you convert the client
data in the middle of a quarter. Also, some manipulation of your data in PDS may be required prior to conversion.
For more information, please refer to the section of this document entitled “Processing Steps Required for Each
Client Prior to Running the Conversion Program.”

PROCESSING STEPS REQUIRED FOR EACH CLIENT PRIOR
TO RUNNING THE CONVERSION PROGRAM
! If you use the After The Fact Payroll module in PDS Client Accounting, you can convert employee current-

quarter and year-to-date earnings for W-2 processing. For this reason, you should convert after finishing the
payroll processing for a quarter or at year-end. For more information regarding the conversion of payroll
amounts, please refer to the section of this document entitled “Items Transferred During Conversion of PDS
Data.”

CONVERTING AND IMPORTING A CLIENT INTO CSA
Use the following steps to convert and import a PDS client into CSA. You may refer to this document for all
information regarding this conversion.

1. Start the CSA program by clicking on the desktop icon for Creative Solutions Accounting.
2. Create a new client in CSA by choosing New Client from the File menu. (For more information on creating

a new client, choose CSA Help Topics from the Help menu and then; in the Index tab of the Help dialog,
choose New Client [File menu].
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Note: When adding the client to CSA, you must complete the current period end date, current fiscal year end,
and current payroll end date exactly as they appear in the PDS system. If you are converting general ledger
and payroll information, you will also need to use the General Ledger Solution and Payroll Compliance
Solution modules when adding the client.

3. From the Utilities menu, point to Data Conversions and then choose PDS.
4. In the first field of the PDS Conversion dialog, enter the location of the PDS program files.

Example: If your PDS-CA program is on drive C, you would enter C:\PDS-CA.
5. In the Client to import field, enter the company ID you want to import.
6. If you wish to convert the employee earnings totals, mark the Convert Employee Earnings checkbox.
7. Click the Import button.
8. Once the import has finished, you should make the necessary changes or corrections to the converted data

as specified in the sections of this document entitled “Items Transferred During Conversion of PDS Data”
and “Conversion Notes and Exceptions.”

ITEMS TRANSFERRED DURING CONVERSION OF PDS DATA
The following tables are provided to identify PDS fields that will be converted to the CSA program. The tables
are organized by PDS and CSA screens and denote the necessary CSA screen navigation

PDS General Ledger Account Information
PDS CLIENT
ACCOUNTING
Field Name

Creative Solutions Accounting
Menu Navigation
Creative Solutions Accounting
Field Name

Comments and additional information

G/L Setup | Chart of Accounts
Acct#

The 3 digit or 4 digit PDS G/L number will be
converted to this field. You have the ability in CSA
to expand the chart of accounts using departments,
etc. Only accounts with balances in any period
during the prior or current year will be converted.
Refer to the online CSA Help Topics for more
information on Chart of Accounts Masks.

Account Type Setup | Chart of Accounts
Type

See “Conversion Notes and Exceptions” below for
more information on the conversion of the account
type.

Account Name Setup | Chart of Accounts
Description

Current Year Balances
Debit or Credit

Setup | Chart of Accounts
Balance

See “Conversion Notes and Exceptions” below for
more information regarding processing clients using
a number of periods not supported by CSA

Prior Year Balances
Debit or Credit

Setup | Chart of Accounts
Balance

Budget Amounts Setup | Chart of Accounts
Budget

See “Conversion Notes and Exceptions” below for
more information on budget and department
information.
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PDS GL Transactions
PDS CLIENT
ACCOUNTING
Field Name

Creative Solutions Accounting
Menu Navigation
Creative Solutions Accounting
Field Name

Comments and additional information

REF Tasks | Transaction Entry
Reference

The journal source indicator will precede the
reference number in this field. For example, S=sales
journal, P=purchases journal, R=receipts journal, D=
disbursements journal, G=general journal, etc.

Date Tasks | Transaction Entry
Transaction Date

The conversion will automatically append the year
onto the transaction during the conversion. For
example, a PDS date of 11/30 will become 11/30/99
in CSA.

G/L Tasks | Transaction Entry
Account Number

Description Tasks | Transaction Entry
Description

Amount Tasks | Transaction Entry
Amount

PDS Employee Information
PDS CLIENT
ACCOUNTING
Field Name

Creative Solutions Accounting
Menu Navigation
Creative Solutions Accounting tab
Creative Solutions Accounting
Field Name

Comments and additional information

Employee Setup | Employees
General tab
ID

Name Setup | Employees
General tab
First

PDS stores the entire name in a single field. The
conversion will parse the field in the same manner
PDS parses for payroll reports.

Name Setup | Employees
General tab
MI

PDS stores the entire name in a single field. The
conversion will parse the field in the same manner
PDS parses for payroll reports.

Name Setup | Employees
General tab
Last

PDS stores the entire name in a single field. The
conversion will parse the field in the same manner
PDS parses for payroll reports.

Street Setup | Employees
General tab
Street

PDS has a Street field as well as a Suite/POBox field.
When the Suite/POBox field is used, the conversion
will combine the two PDS fields into the Street field
in CSA.

City Setup | Employees
General tab
City

State Setup | Employees
General tab
State

Zip Setup | Employees
General tab
Zip
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PDS CLIENT
ACCOUNTING
Field Name

Creative Solutions Accounting
Menu Navigation
Creative Solutions Accounting tab
Creative Solutions Accounting
Field Name

Comments and additional information

Soc. Sec. Setup | Employees
General tab
SSN/EIN

W2 Box [16] State
#1

Setup | Employees
Tax Withholding and Deduction tab
State W/H Properties button
State

W2 Box [19] Local
#1

Setup | Employees
Tax Withholding and Deduction tab
Local W/H properties button
Locality

W2 Box [16] State
#1

Setup | Employees
Other tab | SUTA G/L Accounts
State

Department Setup | Employees
General tab
Department

PDS Employee Earnings Balances
PDS CLIENT
ACCOUNTING
Field Name

Creative Solutions Accounting
Menu Navigation
Creative Solutions Accounting tab
Creative Solutions Accounting
Field Name

Comments and additional information

Current Quarter
Year to Date
Hourly

Setup | Employees
Earnings tab
Wages

If the PDS Pay Type field is marked Hourly, the
amount in the Regular field will become hourly
wages.

Current Quarter
Year to Date
Salaried

Setup | Employees
Earnings tab
Salaried Wages

If the PDS Pay Type field is marked Salaried, the
amount in the Regular field will become salaried
wages.

Current Quarter
Year to Date
Overtime
Premium

Setup | Employees
Earnings tab
Overtime

The conversion will search for the word Overtime in
the Income description field. The conversion will
then add any amount in the Overtime field with
amounts in the Premium field. If you changed the
description from Overtime to any other description, it
will be converted to the other earnings field.

Current Quarter
Year to Date
Commissions

Setup | Employees
Earnings tab
Commissions

The conversion will search for the word
Commissions in the Income description field when
converting amounts to this field. Only exact matches
to the word Commissions will be converted to this
field.

Current Quarter
Year to Date
Bonus

Setup | Employees
Earnings tab
Bonus

The conversion will search for the word Bonus in the
Income description field when converting amounts to
this field. Only exact matches to the word Bonus will
be converted to this field.
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PDS CLIENT
ACCOUNTING
Field Name

Creative Solutions Accounting
Menu Navigation
Creative Solutions Accounting tab
Creative Solutions Accounting
Field Name

Comments and additional information

Current Quarter
Year to Date
Sick

Setup | Employees
Earnings tab
Sick Pay

The conversion will search for the word Sick in the
Income description field when converting amounts to
this field. Only exact matches to the word Sick will
be converted to this field. A description of Sick Pay
will be considered a match by the conversion and
convert the amount to this field.

Current Quarter
Year to Date
Vacation

Setup | Employees
Earnings tab
Vacation

The conversion will search for the word Vacation in
the Income description field when converting
amounts to this field. Only exact matches to the word
Vacation will be converted to this field.

Current Quarter
Year to Date
Tips

Setup | Employees
Earnings tab
Reported Tips

This amount will come from the Tips field in the
PDS Edit Employee File-Balances screen 4 of 5.

Current Quarter
Year to Date
Other

Setup | Employees
Earnings tab
Other Wages

This field will contain all other wage and earnings
fields set up in PDS that are not listed above. Once
the conversion is complete, you should break out this
amount into their respective pay types in CSA. The
meals field in PDS Edit Employee File-Balances
screen 4 of 5 also converts to this field.

Current Quarter
Year to Date
FICA Ret

Setup | Employees
Tax Withholdings and Deductions
tab
FICA-SS

Current Quarter
Year to Date
FICA Med

Setup | Employees
Tax Withholdings and Deductions
tab
FICA-Med

Current Quarter
Year to Date
FIT

Setup | Employees
Tax Withholdings and Deductions
tab
Federal W/H

Current Quarter
Year to Date
SIT

Setup | Employees
Tax Withholdings and Deductions
tab
State W/H

See “Conversion Notes and Exceptions” below for
more information on the conversion of SIT amounts.

Current Quarter
Year to Date
CIT

Setup | Employees
Tax Withholdings and Deductions
tab
Local W/H

See “Conversion Notes and Exceptions” below for
more information on the conversion of CIT amounts.

Current Quarter
Year to Date
Oth Ded4

Setup | Employees
Tax Withholdings and Deductions
tab
401K % of Gross

If you use PDS field Oth Ded4 for 401K
contributions, the amount will convert to this field.
For more information on conversion of 401K
amounts, see “Conversion Notes and Exceptions”
below.

Current Quarter
Year to Date
Sect 125 Plans

Setup | Employees
Tax Withholdings and Deductions
tab
Other Deductions

If the Sect 125 indicator location in the Client File
screen 3 of 6 has a number indicating which of the 6
other pay fields contains cafeteria plans, it will be
converted to the Other Deductions field in CSA and
will need to be broken out of the total once the
conversion is completed.
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PDS CLIENT
ACCOUNTING
Field Name

Creative Solutions Accounting
Menu Navigation
Creative Solutions Accounting tab
Creative Solutions Accounting
Field Name

Comments and additional information

Current Quarter
Year to Date
Oth Ded 1 – Oth
Ded6

Setup | Employees
Tax Withholdings and Deductions
tab
Other Deductions

Amounts in PDS fields Oth Ded1 through Oth Ded 6
will be converted to this field unless certain criteria
listed above are met for PDS field Oth Ded4.

PDS Vendor Information
PDS CLIENT
ACCOUNTING
Field Name

Creative Solutions Accounting
Menu Navigation
Creative Solutions Accounting tab
Creative Solutions Accounting
Field Name

Comments and additional information

Vendor Setup | Vendors
General tab
Vendor ID

Name Setup | Vendors
General tab
Name

The PDS Name field is 40 characters long. The CSA
Name field is 15 characters long. Only the 1st 15
characters of the name will be converted

Street Setup | Vendors
General tab
Street

Suite / P.O.Box Setup | Vendors
General tab
Street

When the Suite/P.O.Box field is used, the conversion
will combine the two PDS fields into the Street field
in CSA.

City Setup | Vendors
General tab
City

State Setup | Vendors
General tab
State

Zip Setup | Vendors
General tab
Zip

Soc. Sec. or EIN Setup | Vendors
General tab
SSN

The SSN or EIN will be converted based upon the
formatting entered in the PDS Soc. Sec. or EIN field.
If no formatting exists, the field will be converted as
a SSN.

Telephone Setup | Vendors
General tab
Phone

G/L Account Setup | Vendors
General tab
Account #

Payments Setup | Vendors
Distributions tab
Year to date checks

This amount represents the year-to-date checks paid
to the vendor. It does not break the amounts up into
1099 type. If there are multiple 1099 type payments,
you will need to break this information apart in CSA
upon the completion of the conversion
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ITEMS NOT TRANSFERRED DURING
CONVERSION OF PDS DATA
Although most PDS data is converted, some data cannot be converted due to differences in program features and data
structures between PDS and CSA. If an item below is denoted with an asterisk (*), it is further explained in the
“Conversion Notes and Exceptions” section of this document. The following items, which cannot be converted, are
organized by PDS screen.

General Client Information
Company ID, name, address, contact name, phone number, federal ID number, State ID number, State unemployment
ID number, client password, fiscal year end, and inventory information cannot be converted. All of this information
should be set up while adding the client to CSA, or you can add it later in the File / Client Properties dialog.

Client File Chart of Accounts Information
Profit or loss account, statement rounding account, A/R discount account, A/R sales tax account, A/P discount
account, number of balance sheet accounts, number of income and expense accounts, number of departments, name
of departments, and number of A/R products cannot be converted.

Client Documents and Reports
General ledger reports, payroll reports, client notes, check formats, and user defined fields cannot be converted.

Journal Entry Information
Journal codes, titles, sort sequences, and item and detail formats cannot be converted. Automatic adjusting entry
information such as payroll adjustments information, employer payroll adjustment information, gross profit
adjustments information, and all other setup information for automatic adjusting entries cannot be converted.

Financial Statements
Report Formats, Report Details, Notes Files, and Style Sheets cannot be converted.

Employee Information
Position, date hired, date left, G/L account, department, sort by field, exempt marker for FICA/FUTA/SUTA, base
rate, O.T. rate, premium rate, normal hours, hours regular and overtime, weeks worked per quarter, W2 box 14
miscellaneous information fields 1, 2 and 3, state tax tables, additional and recurring wages/deductions, number of
dependents and W-2 box 15 indicators cannot be converted.

Payroll Transactions / Prior Balances
Check number, transaction date, employee name and amounts for the current year as well as prior years cannot be
converted. Earnings for quarters other than the current quarter in the current fiscal year end cannot be converted.

Additionally, earnings balances for the current period and prior years cannot be converted. Only the earnings for
current quarter and year-to-date can be converted to enable you to process W-2s and current-quarter payroll reports.
(Note: The current-period balances will be included in the quarter-to-date and year-to-date balances.)

Tax Line Grouping Codes
Because PDS allows you to enter tax line grouping codes for a number of different tax products, it is impossible to
determine that the tax line grouping code entered is for UltraTax (DOS) or UltraTax for Windows. The tax line codes
will therefore need to be manually entered once the conversion has been completed.
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Vendor Information
DBA, department, 1099 type, 1099 box number, sort name by field, month-to-date payment information, month-to-
date and year-to-date purchase and discounts, prior-year purchases and discount amounts, current accounts receivable
aging information, and recurring amount information cannot be converted.

Other Information
Bank reconciliation module information, accounts receivable module information, accounts payable module
information, and inventory module information cannot be converted.

CONVERSION NOTES AND EXCEPTIONS
The following section details all known conversion exceptions between PDS data and the converted CSA data.
Conversion exceptions may include differences in field lengths between PDS and CSA, required parsing of
information from one field in PDS to multiple fields in CSA, and manipulation of PDS data to conform with CSA
requirements, and so forth.

G/L Account Types
PDS does not have an account type marker as required by CSA to distinguish assets from liabilities, etc. The
conversion utility uses the following table to determine whether an account is an asset, liability, equity, income, or
expense account. This format follows the default Chart of Accounts that is released by PDS. If the client’s Chart of
Accounts does not fall within the tables below, you will need to manually change the account in CSA after the
conversion has been completed.

PDS Account Number
Range

Account Description CSA Account Type

100-199 or
1000-1999

Assets A

200-299 or
2000-2999

Liabilities L

300-399 or
3000-3999

Equity L

400-499 or
4000-4999

Revenue R

500-599 or
5000-5999

Expense E

600-699 or
6000-6999

Expense E

700-799 or
7000-7999

Expense E

800-899 or
8000-8999

Revenue R

900-999 or
9000-9999

Expense E

PDS Budgeting and Departmentalized Accounting Modules
The conversion utility is unable to convert information from the Budgeting and Departmentalized Accounting
Module sold by PDS. All department and budget information will need to be manually entered into the CSA program
once the conversion is complete.
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CSA Combining Accounts
PDS departments are functionally similar to CSA departments, with one significant difference. The departments in
PDS were only available when you purchased the Budgeting and Departmentalized Accounting module from PDS.
CSA allows you to define “combining” accounts, which link individual department accounts and combine their
amounts for reporting purposes. No transactions can be posted to a combining account and no balances need to be
entered. These accounts are simply used to combine general balances for accounts that have already been posted to.
For more information about setting up and using combining accounts, start the CSA program, choose Help / CSA
Help Topics, click the Index tab in the Help dialog, and type Combining accounts setup.

Clients Using Processing Periods Other than Annual,
Quarterly, Monthly, or 13 Period
CSA allows you to process clients using Annual, Quarterly, Monthly, 13 period, or weekly (not available in PDS).
PDS allowed for the processing of clients using any number of months. If you convert a client that is a two-period
processor, balances are converted to the second- and fourth-quarter balance fields in CSA. You will need to add this
client to CSA as a quarterly processor and only use the 2nd and 4th quarters for processing. All PDS companies with
3,5,6,7,10, or 11 periods will be converted as annual CSA clients. Therefore, when adding such a client to CSA, you
will need to add it as an annual client.

State Income Taxes Withheld (SIT)
If the second state indicator field (located on Client File screen 3 of 6) has a deduction number, amounts located in
that deduction field will be added to the first SIT amount and the combined number will be converted to the State
Withheld field in CSA. This amount will need to be broken out in CSA once the conversion is completed.

City Income Taxes Withheld (CIT)
If the second city indicator field (located on Client File screen 3 of 6) has a deduction number, amounts located in
that deduction field will be added to the first CIT amount and the combined number will be converted to the Local
withheld field in CSA. This amount will need to be broken out in CSA once the conversion is completed.

Security
Although PDS and CSA both offer a security feature (passwords), the security passwords for each client cannot be
converted due to differences in the data structure in each program. If you wish to use the security feature in CSA,
please refer to the one CSA Help Topics.

ERROR LOG AND VERIFYING YOUR CONVERTED DATA
Although the conversion has been designed to convert your data as accurately as possible, there are some instances when
the conversion may not convert all data correctly due to PDS data corruption and other anomalies within the PDS data.
You should follow the steps below to verify that your PDS data has been converted correctly.

1. Start Creative Solutions Accounting and open the new client that was created. From the File menu, choose Open
Client. In the Open Client dialog, double-click the appropriate Client ID.

2. From PDS, print the Current Period General Ledger and Trial Balance Report.
3. From CSA, print the CSA General Ledger and Trial Balance reports.
4. Compare the two sets of reports. If the information contained on the PDS reports does not match the CSA reports,

you will need to determine which transaction(s) are invalid or missing and manually enter the transactions into
CSA. Other reports are available in both systems if you cannot determine the discrepancy using the above-listed
reports.

5. From PDS, print the Quarterly Wage Report and Tax Summary report in PDS.
6. From CSA, print the Payroll Tax Summary Report.
7. Compare the amounts on the PDS and CSA payroll reports and note any discrepancies. You may make manual

changes to any payroll amount in the CSA program.
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If problems are encountered
If problems are encountered during the conversion of your client from PDS Client Accounting Client Accounting to
Creative Solutions Accounting and you are unable to reconcile the data using the various reports and tools in CSA,
contact CSI Product Support.

SUPPORT
Web Site
If you have questions or need assistance, you can visit our Web site at www.CreativeSolutions.com 24 hours a day
for the latest information on current issues and processing tips. To take advantage of this convenient means of
accessing information, choose CSI on the Web from the CSA Help menu, and then click Product Support and
Service.

Product Support
To speak with a Product Support Representative, please call the CSI HelpLine at 800-968-0600, press 3 for
accounting support, and then listen to the options available before pressing the number for Creative Solutions
Accounting. Normal weekday support is from 9:00 AM to 8:00 PM Eastern Time.
TL4185
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